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 Presentation

Welcome to Vincent version 2.    This is a powerful yet simple to use package designed for 
any technical or graphical drawing. This is a vector drawing software for Windows 3.1 or 
better.

Vincent is distributed as a shareware program.

Vincent    responds a wide variety of drawing processing needs :

• You can draw rectangles, squares, ellipses, circles, single lines and broken lines, cubic 
and quadratic splines and Bezier curves, arcs, stars...

• Texts can be placed in your document using TrueType, Atm or other Windows fonts. 
Vincent provides special fonts.

• You can input bitmap images or metafile objects issued from differents other programs. 
Vincent objects can be placed in clipboard as bitmap or metafile objects.

• Objects you create can be sized, moved, grouped, deleted, modified, aligned, put 
in rotation or in symmetry, italicized, submitted to deformation (spherical 
projection, sinusoid, etc.), and so on.

• Objects can be placed and moved to differents layers 

• Grids, guides and zoom allows you to draw with more precision.

• Many clipart pictures are available from Clipart dialog box.

Feel free to share Vincent with your friends. Vincent is a "shareware program" and is 
provided at no charge to the user for evaluation. (Disk vendors may charge for distribution. 
Please contact our local agents for permission to distribute). 

Registration fee is £49.00 + VAT. For that price you get user license, a new version of 
Vincent, help in English, 25 fonts, 2 000 clipart pictures.See for more information Why to 
register help topic.

Print registration form from print command of file menu of this help.

When you register, you will help us to develop this product further!



Shareware

Vincent is a "shareware", that means that If you continue to use Vincent 
after 30 days , you must make a registration payment to the authors. You 
will receive then a license, a complete version of Vincent and more than 2 
000 clipart pictures.
Why you must register
Registration form



Why you must register 

When you register you help us to provide you with a better version later.

All registered users will receive soon:
• your license.
• 25 vector fonts.
• more than 2 000 clipart pictures.
• removal of the following shareware version features

- 'nag' screens when loading or saving a file, using Split text 
command.

- Buttons of the Print dialog box playing with your nerves after 45 days 
of non registered using. Message printed after 90 days.

- only one undo level available at least of nine (Preferences dialog 
box).

- no saving of Toolbars configuration.
- no Copy or Cut metafile version of selected objects in the clipboard.
- message "This is an unregistered version" when using Fit on screen 
command (Zoom menu).

You can order by payment with cheque, eurocheque or credit card.

UNITED KINGDOM:
The Thompson Partnership
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Market Place,
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ST14 8HZ
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FRANCE and other countries:
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What's new?

New functions:
 Quotation/Extremities. Quotations with varieus extremities (arrow, triangle, lozenge, 

cercle, square), localisation, scale, etc.
 Postscript export., separation.
 Bitmap import formats available: Bmp (all formats), TGA (compressed or not), PCX 

(monochrome). All import formats (vectorial or bitmap) drag and drop.
 Customised toolbars.
 Styles gestion: copy and paste a style (all parameters of a drawing or a Vincent text like 

thickness, filled colour, font, etc.).
 boîte de dialogue Paste Special  dialog box to choose easily Paste format (metafile, 

bitmap...).
 New layers gestion, much more easy to use,thanks to new Layers control window you 

can keep open.
 Information window giving information about selected elements (you can keep it open 

too).
 Complete Print dialog box: count copies, scale (overlap), fit on paper, printer type end 

printer configuration, quick printing, centered, name and date of file, etc.
 Zoom menu: zoom on selection, full screen, from 100 to 800 % (with zoom rectangle: 

from 40 to 1000 %)...
 In between: number of steps...
 Diffusion tool: diffusion of vector elements (like circles, triangles, square) for comet like 

effects.
 Mask: an attribute to get bitmap or vector elements (drawings, Vincent text, paving, etc.) 

visible only inside a vector element.
 Conversion of Vincent text into curves.
 New Palette colours dialog box (Hue, Saturation, Light...).

Main improvements:
 Import HPGL ('.PLT), drag and drop HPGL. dialog box with many options 
 Export WMF resizable Aldus format.
 Arrange: Background command to send the selection into the background.
 Consecutive selection with TAB key. 
 Selection blocks with horizontal and vertical handles.
 Real time moving element contour.
 Paste a DIB from clipboard.
 Copy gradation into metafile in clipboard.
 Automatic creation of guides.
 Zoom with '+' et '-' keys.
 Moving selection with keyboard (Shift + arrow keys).
 Moving active document window with keyboard (Ctrl + arrow keys).
 etc.



Registration form
Print    this form with Print command of File menu of this help.

Name:              _______________________________________

Company:    _______________________________________

Address:      _______________________________________

                                _______________________________________

                                _______________________________________

Telephone number:            _____________________________

Quantity Total

Vincent 2.1 £ 49.00 X ___________ = ___________

Shipping + £ 3.00

VAT @ 17.5% + ___________

TOTAL = ___________

Make cheques payable to: 
The Thompson Partnership

You can order by payment with cheque, eurocheque or credit card.

Credit card type___________________________

Credit card number:
_______    _______    _______    _______    

Expiration date: ____/____ /____    

Date ____/____ /____          Signature :    _________________

Mail to: 
The Thompson Partnership
Lion Buildings,
Market Place,
UTTOXETER
Staffs
ST14 8HZ

Suggests & Criticism:

________________________________________________

________________________________________________

________________________________________________

________________________________________________

Where did you hear about Vincent?

_______________________________________________





Agent/Publisher of B&L shareware products.

UNITED KINGDOM :
The Thompson Partnership
Lion Buildings,
Market Place,
UTTOXETER
Staffs
ST14 8HZ
Telephone : +44 (0) 1889 564601
Fax : +44 (0) 1889 563219
BBS : +44 (0) 1889 568625
CIS : 70007,5560
Internet : SALES@TTP.CO.UK

FRANCE and other countries:
B&L LOGICIELS
105, avenue Ernest RENAN
18000 BOURGES
FRANCE
Telephone: (+33) 48.20.81.24 
Fax: (+33) 48.20.63.51



Windows text editor

File   menu  
Edit   menu  
Search   menu  
Fonts   menu  
Size   menu  
Style   menu  
Align   menu  

Activate an Icon:
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

open standart Windows Fonts dialog box.

To open Windows text editor:
• select text block and activate simultaneously Control key and E key or click    the Text 
tool with the right mouse button.

• A text editor is create for each Windows text block.

See:Create a Windows text block



File menu    Windows text editor

•  Open command: opens a file selector for opening Ascii or Ansi text. Default is Ansi. 
You can convert Ascii text into Ansi.

•  Apply command: applies to Windows text block, if selected, all modifications 
caused into text editor.

•  Lettrine command: opens a dialog box Lettrine where you specify the size of an
area on the top and left side of the text block.

•  Keyboard command: opens Keyboard accessory.

•  Quit command: closes editor and applies to the text block text an attributes specified 
into editor.



Edit menu    Windows text editor

•  Undo command: undoes last action.

•  Cut command: detetes selected text and puts a copy into the Clipboard.

•  Copy command: puts a copy of selected text into the Clipboard.

•  Paste command: inserts the text of the Clipboard at the cursor position.

•  Delete command: deletes selected text.

• Delete all command: deletes all the text.



Search menu    Windows text editor

• Find... command: opens a dialog box where you specify the text to found. 
When the Case Sensitive option is on, Vincent differentiates uppercase from lowercase 
when performing a search.

• Replace... command: opens a dialog box where you specify the text to found and the 
new text.    An option exists to differentiate uppercase from lowercase when performing a 
search, to replace all occurences and to confirm or not each substitution.

•  Next command: to search again text specified into Find or Replace dialog boxes.



Fonts menu Windows text editor

Displays in alphabetical order all Windows fonts available (TrueType,Poscript ATM, etc.)



Size menu    Windows text editor

Displays a choice of character sizes.



Style menu    Windows text editor

• Bold, Italic, Strikeout, Underline commands, separately or simultaneously.

• Normal command: default option. Disable other styles.



Align menu    Windows text editor

To align and justify Windows text.

•  Left command: align text on left.

•  Right command: align text on right.

•  Center command: centre text between left and right sides.

• Justify command: align text on left and right.



Clipart

Clipart are predefined graphic elements.

Clipart are ordered in files with '.TEO' extension (so you may    access to cliparts by Open 
command of File menu).

The Clip-Art dialog box accessible with the Clipart... command of the File menu allows you
accessing clipart more efficiently.

Clipart are grouped.
Use Separate command (Ctrl + S) to select and modify separatly each element of a group.



Glossary

Approach
Attributes

Bitmap
Block control points

Drawing path
Duplicate

Element

Gradation angle
Grid
Group
Guide

Path control point

Rulers

Status line
Style

Vincent Text

Windows Text



Drive Surface

Drive Surface (program Drvsurf.exe) is a surface editor.

These surfaces can be paste into Vincent.

To improve surfaces (colour, gradation...) use Edit Drive Surface from Attributes popup 
menu opening Bezier surface dialog box.

Drvsurf.exe has its own help menu (?).



Shortcuts
Keystroke(s) Action

Ctrl + N Creates a new document.
Ctrl + O Opens a document.
Ctrl + P Prints the active document.
Ctrl + G Groups selected objects in a single object.
Ctrl + S Ungroups a selected group.
Ctrl + X Duplicates selected object(s)..
Ctrl + T Selects all the objects of the active layer if the active document.
Ctrl + E Activates the Edit command of the Modify menu.
Ctrl + V Activates the Paving command of the Modify menu
Ctrl + I Opens the Info window.

+ Zooms in
- Zooms out
/ Zooms on the selection.
* Displays all the document.

F8 Displays the visible part of the active document on the whole screen 
(Full screen command of the Zoom menu.

F9 Displays either the most important part of the document, (if possible
all the document) or zoom with a 100% rate

Alt+BkSp Undoes
Shift + Alt + BkSp Redoes
Del Deletes

Ctrl + Shift + R Moves the selected object(s) in the foreground.
Ctrl + Shift + D Moves the selected object(s) before the element following the first 

element of the selection (as Above command).
Ctrl + Shift + E Moves the selected object(s) behind the preceding element (as 

Below command).
Ctrl + Shift + P Moves the selected object(s) in the foreground.

Ctrl + Shift + V Applies to selected objects a vertical symmetry.
Ctrl + Shift + H Applies to selected objects a horizontal symmetry.

Ctrl + Shift + A Assembles selected objects in a single object.
Ctrl + Shift + S Disassembles an element beforehand assembled.

Ctrl + Shift + G Opens the Grid dialog box.
Ctrl + Shift + T Opens the Preferences dialog box.

Left arrow Moves the document to the right.
Right arrow Moves the document to the left.
Top arrow Moves the document downward.
Bottom arrow Moves the document upwards.

Shift + Left arrow Moves the selection to the left according to the step of the magnetic 
grid.

Shift + Right arrow Moves the selection to the right according to the step of the 
magnetic grid.

Shift + Top arrow Moves the selection upwards according to the step of the magnetic 



grid.
Shift + Bottom arrowMoves the selection downwards according to the step of the 

magnetic grid.

Ctrl + Shift + 0 .. 9 Keeps in memory zoom rate and translators position.
Ctrl + 0 .. 9 Retrieves from memory a zoom rate and translators position.

    note: 0..9 keys have to be activated on the upper part of 
keyboard.

Tab Selects consecutively the elements according to their order of 
display.

Shift + Tab Selects consecutively the elements according to the reverse order 
of their display.

Shift + F5 Piles windows of drawing.
Shift + F4 Reorganizes the display of drawing windows in mosaic, in such a way

that they do not cover each other.

Shift + F1 Opens Vincent help module.
F1 Activates the contextual help cursor.

TOOLS
a, A, 7 Text.
z, Z, 8 Zoom.
e, E, 9 Arrow.
q, Q, 4 Ellipse.
s, S, 5 Rectangle.
d, D, 6 Rounded corner rectangle.
w, W, 1 Arc.
x, X, 2 Line.
c, C, 3 Cubic splines.
0 (zero) Stars.



Configuring Vincent with Vincent.ini

[Vincent]
Coordinates=Yes

Indicates whether Yes or No the mouse coordinates are dispalayed on the status line.
Compression=No

Indicates whether Yes or No the Vincent files are saved with a compressed mode.
Bitmap=Yes

Indicates whether Yes or No Vincent puts in the clipboard a bitmap version when using 
Copy or Cut command of Edit menu.

Image=Yes
Indicates whether Yes or No Vincent puts in the clipboard a metafile version when using 
Copy or Cut command of Edit menu.

Palette=No
Indicates whether Yes or No the floating palette is displayed when launching Vincent.

Saving copy=Yes
Indicates whether Yes or No Vincent make a saving copy (with ".TBK file extension) when 
using the Save command of File menu.

Sélectors31=Oui
Indicates whether Yes or No Vincent opens sandards Windows 3.1 file selectors.

Control points in color=Yes
Displays Control drawing points with color according to the type of points:

line points in bleu
arc points in green
spline points in red...

Fast gradation=Yes
Displays (only on screen) the gradations in a fast mode (with a limited number of 
bands).

Move full shape=Yes
The contour of drawing objects is visible during their moving.

Save Metafile=Yes
Vincent save a metafile version (with ".WMF" file extension) when using the Save or Save
as... command of File menu.

Color palette=Yes
The active color palette is saved into the document.

Rulers=Yes
Indicates whether Yes or No the rulers are displayed.

Undo levels number=3
The three last operation may be undone (from 0 to 9).

Coordinates Inch=No
Indicates whether Yes or No the unit of the coordinates on the status line are in inches 
(either in mm).

Rulers Inch=No
Indicates whether Yes or No the unit of the rulers is the inch (either    mm).

Grid Inch=No
Indicates whether Yes or No the unit of the grids is the inch (either    mm).

Palette 256=No
Indicates whether Yes or No Vincent uses a palette with only pure colours (see 
Preferences). 

Fixed Palette=Yes
Indicates whether Yes or No the fixed palette is displayed at the launching of Vincent 
(see Preferences).

Info Bubble=No
Indicates whether Yes or No the Info Bubbles are displayed when displacing the mouse 
over toolbars.



Bel Icones activated=Yes
Indicates whether Yes or No the toolbars are displayed (by activating the option Active of
the Iconbars configuration dialog box.

Blue frame=Yes
Indicates whether Yes or No Vincent displays a blue frame around the page (see 
Preferences).

Progression=Yes
Indicates whether Yes or No the Vincent displays progression bars on the bottom of the 
screen, indicating the programm is working (see Preferences).

Large palette=Yes
Indicates whether Yes or No Vincent displays a big palette window (see Preferences).. 

Large tools=Yes
Indicates whether Yes or No Vincent displays bigs tools window (see Preferences).. 

Small Ctrl Pt=Yes
Indicates whether Yes or No the objects inside a group display small points at their 
corners (see Preferences).

With Rectangle=No
Indicates whether Yes or No each object displays a rectangle when moving (see 
Preferences).

Big Icon=No
Indicates whether Yes or No the Iconbars are displayed with big icons (option Big of the    
Iconbars configuration dialog box.).

Frame Win Rect=Yes
Indicates whether Yes or No a frame is displayed around the Windows texts when not 
selected. If No    the frames are not displayed.

[Directory]
Fonts=C:\VINCENT

Indicates the directory of the Vincent fonts (extension:".FW").
Help=C:\VINCENT

Indicates the directory of the Vincent help file: Vincent.hlp.
Teo=C:\VINCENT\TEO

Indicates the directory where the Vincent file ("*.TEO") have been opened or saved the 
last using of the Open, Save or Save as...commands of File menu before to quit 
Vincent.

Dc=C:\VINCENT\DC
Indicates the directory of the cliparts manager file (DC.DC).

BMP=C:\VINCENT\BITMAP
Indicates the directory where are have been exported bitmap file ("*.BMP") the last using 
of the Export|Image BMP or    Import|Image BMP commands of File menu. File 
selectors will propose that directory when using that command next time.

PLT=C:\VINCENT\PLT
Indicates the directory where have been exported HPGL file ("*.PLT") the last using of the 
Export|Ploter HPGL or    Import|Ploter HPGL commands of File menu. File selectors 
will propose that directory when using that command next time.

PS=C:\VINCENT\FLASH
Indicates the directory where have been exported Postscript file ("*.PS") the last using of
the Export|Postscript PS... command of File menu. File selectors will propose that 
directory when using that command next time.

TXT=C:\VINCENT
Indicates the directory where have been imported Text file (".TXT") the last using of the 
Import|Script TXT command of File menu. File selectors will propose that directory 
when using that command next time.

WMF=C:\VINCENT



Indicates the directory where have been exported metafile file ("*.WMF") the last using 
of the Export|Vector WMF or    Import|Vector... WMF commands of File menu. File 
selectors will propose that directory when using that command next time.

TGA=C:\VINCENT
Indicates the directory where are have been exported bitmap file ("*.TGA") the last using 
of the Import|Image... TGA commands of File menu. File selectors will propose that 
directory when using that command next time.

PCX=C:\VINCENT
Indicates the directory where are have been exported bitmap file ("*.PCX") the last using 
of the Import|Image PCX commands of File menu. File selectors will propose that 
directory when using that command next time.

[Grid]
Visible=Yes

Indicates whether Yes or No the Visual grid is visible.
Active=No

Indicates whether Yes or No the Magnetic grid is active
Visual step X=10

Indicates the X step for the Visual grid.
Visual step Y=10

Indicates the Y step for the Visual grid.
Magnetic step X=1

Indicates the X step for the Magnetic grid.
Magnetic step Y=1

Indicates the Y step for the Magnetic grid.

[Program]
To launch external programs from the Vincent Options menu.

//Exemple:
1=&Drive Surface..., c:\windows\vincent\Bzsurfac.exe
2=&ClipBoard..., c:\windows\Clipbrd.exe
3=&NotePad..., c:\windows\Notepad.exe
4=&Vincent.Ini..., c:\windows\Notepad.exe c:\windows\Vincent.ini

[Files]
NB=6

Number of files names indicated on the File menu (see 1, 2, 3 .. File name).
Max=6

Maximum number of files indicated on the File menu.
1=c:\vincent\demos\bip.teo
2=c:\vincent\etiquette\etiq_4d5.teo
...{Files names to open}

[Config Page]
Saving of the parameters of the Page configuration... dialog box.
Size=2

Page format is A4:
1 - A5: 148 X 210
2 - A4: 210 X 297
3 - A3: 297 X 420
4 - B5: 182 X 257



5 - B4: 250 X 353
6 - Tabloid: 279,4 X 431,8
7 - US Letter: 215,9 X 279,4
8 - US Legal: 215,9 X 355,6

Orientation=1
Page orientation is Portrait.
2 - Landscape

Coulor=16777215
Indicates the colour of the paper (not printed).

Other X=210
Indicates the X page size.

Other Y=297
Indicates the Y page size.

[Bitmap]
Configures the sub-menu opened by the Edit bitmap command of the popup attributes 
menu.
Nb=2

The number of programs.
1=PBRUSH.EXE
2=c:\windows\graphy\psp\psp.exe
...{names of the programs to launch.

[Line]
Saving of the parameters of the Line thickness dialog box (accessible from the 
Preferences dialog box.

[HPGL]
0=7
Indicates that all the options of the HPGL Import dialog box are checked (0=0: all options 
unchecked).
1=0,1
2=16711680,2
3=255,4
4=65280,1
5=128,1
6=8421504,1
7=12632256,1
8=8388608,1
Numero of plotter= RGB decimal colour conversion,line thickness

[Templates]
NB=4
Max=6
1=C:\vincent\demo\bulletin.teo
2=C:\vincent\demo\beacholy.teo
3=C:\vincent\demo\sophie.teo
4=C:\vincent\demo\victori.teo



 Toolbars

Most of Vincent menu commands are accessible from icons.

File Menu

New
Open...
Commande Save
Save as

Cliparts...
Template...

Plotter... HPGL
Image... PCX
Image... BMP
Image... TGA
Vector ... WMF

Vector ... WMF
Plotter... HPGL
Image... BMP
Postscript...PS

Print...
Control panel...
Exit

Edit  menu

Undo
Redo
Delete
Cut
Copy
Paste
Duplicate
Copy style
Paste style
Select all



Modify menu

Group
Paving
Ungroup
Edit
Information...
Background
Above
Below
Foreground
Top
Bottom
Right
Left
Center horizontal
Center Vertical
Horizontal symmetry
Vertical symmetry
Assemble
Disassemble
Sinusoïd
Blend shapes...

Options menu 

Grd...
Page configuration...
Preferences...
Colour palette
Rulers
Toolbars
Quick display
Display bitmap

Attributes menu

Vincent text...



Drawing...
Quotation...
Colour...
Gradation...
Keyboard...
Layers...

Zoom menu 

Fit on screen
On selection

Windows menu

Cascade
Tile
Close all

? menu 

Context sensitive help

Others:

Applies to selected drawing path(es)
lines thicknesses predefined with the Line Thickness dialog box accessible from the 
Preferences dialog box.

Applies a thickness=0 to selected drawing path(es).

Text editor

Open... command    File menu 
Apply command File menu 
Lettering...command    File menu 
Keyboard...command File menu 

 Quit command    File menu 

Undo command    Edit menu
Cut command Edit menu
Copy command    Edit menu
Paste command    Edit menu



Delete command    Edit menu

Find... command    Search menu
Next command    Search menu

opens the standard Windows Polices dialog box.

Left command    Align menu
Right command    Align menu
Centre command    Align menu
Justify command Align menu



Tools box

The tools box contain tools for drawing, editing text, deforming objects, zooming, etc.
This box can be displaced wherever on the screen.

      Text
      Zoom
      Arrow
      Ellipse
      Rectangle
      Rounded corners rectangle
      Arc
      Line
      Cubic spline
      Stars
      Quadratic spline
      Bezier
      Rotation
      Spherical and Black hole projection
      Skew
      Comet
      Scissors
      Multi

Common properties of drawing tools

      Origin



Text tool Text 

Keyboard shortcuts: 'a', 'A', '7'.

Allows the editing of text into the active drawing window.

With Vincent you can create two different kinds of text: one is Vincent text using special 
vectorial fonts and ideal for the realization of titles or texts with deformations. The second 
is Windows text blocks using all Windows fonts like TrueType, ATM, etc.

To create Vincent text.

To create Windows text block.

To modify Vincent text attributes

To modify Windows text attributes

Note: Windows texts are easily recognizable on screen thanks to their rectangular dotted 
lines.



To create Vincent text

Two methods:
*1 - the direct addition into the drawing window:

• Activate the Text tool .
• Click with the left mouse button in the wished position: a cursor appears (the size of 
this cursor is proportional to the size of character of the active font.
• Edit the text.

*2 - using a text editor:
• Activate the Text tool .

• Click with the left mouse button at the position you want the text begin. 
• Activate simultaneously the Ctrl and E keys,
• or activate the Edit command of the Modify menu or of the popup Attributes 
menu.,
• or clic with right mouse button on the Text tool,
• edit the text.

To modify the text of a Vincent text previously created:
• Select the text.
• Activate simultaneously the Ctrl and E keys, or activate the Edit command of Modify 

menu, or clic with right mouse button on the Text tool.
• modify the text.

The text is displayed with the active font and attributes. To change the font or the text 
attributes, use the Vincent Text... command of Attributes menu or popup Attributes 
menu.
The font can also be changed with the Font command of popup Attributes menu.

Use the Keybord accessory to edit and/or to search a particular character of a font.



To create a Windows text block 

• Activate Text tool 
• Press the Ctrl key and draw a rectangle. Then Vincent opens the Windows text 
editor.
• Note: the rectangle will contain the text. 
• Edit the text.
• Select attributes (size, style, font, etc.).
• Activate Apply command of File menu of the Windows text editor.

Note 1:the option Transparent of the Drawing... dialog box allows the display of the text 
without background.

Note 2:the text can appear with some defects on screen. This does not affect printing.

To modify a Windows text block:
• Select a Windows text block.
• Activate simultaneously the Ctrl and E keys,
• or activate the Edit command of the Modify menu or of the popup Attributes menu.,
• or clic with right mouse button on the Text tool,
• modify the text and its attributes into the Windows text editor.

Note: several Windows text editors can be opened simultaneously.



Zoom tool 

Keyboard shortcuts: 'z', 'Z', '8'. 

The Zoom tool allows the display of the document to be enlarged or reduced. 

Zoom menu contains commands allowing to display all document (as possible), to zoom on 
the selection, to zoom by 100% step, and to display only the document on screen.

Whatever is the rate of zoom, all Vincent functions are available.

To zoom on a part of the document:
• Activate zoom tool (click with left mouse button)
• Draw a rectangle around the zone to enlarge.
• Release the mouse button.

Use '+' and '-' keys to zoom in and to zoom out.

To display the document to it real size (zoom=100%) or to come back to the 
default zoom::

• Click on the Zoom tool with the right mouse button.
or
• Activate F9 key.

Note: the maximum rate for the zoom is 1000 %, the minimum rate is 40 %.



To select objects 

To select one object:
• Activate the Arrow tool (clic with left mouse button).
• Clic on an object.

To select several objects:
• Select the wished elements while holding the Shift key down.
or:
• Activate the Arrow tool.
• Draw a rectangle around the objects to select.

Notes: when one or several elements are selected:
1 Vincent shows the selection displaying, at the four corners and on the sides, blocks 

control points allowing the deformation of the objects
2 When a single element is selected path control points also appear. These path control 

points can be moved or deleted (Suppr key). New path control points of different types 
(line, arc, spline...) can be insert (see To Modify the contour of an element).

3 the Tab key alows to select consecutively the elements according to their order of 
display. to select consecutively elements in reverse order, activate at the same time the 
Tab the Shift keys.



To move objects 

To move objects with the mouse:
• Select one or several objects.
• Maintain the left mouse buton down while displacing the selection up to the wished 

position.
Note: during displacement the objects display their contour. To move only a rectangle 

containing the selection, activate simultaneously the left and right mouse buttons. 
To reverse this functioning, activate the Fast movings checkbox of the 
Preferences dialog box.

To move objects with the keyboard:
• Select one or several objects.
• Maintain the Shift key down while activating an arrow key (top, bottom, right or left).
• The consequent displacement corresponds to the step of the magnetic grid.

To move with the keyboard the document inside the drawing window:
• Maintain the Ctrl key down while activating an arrow key (top, bottom, right or left).

Note: it is possible to move an object from a document to an other opened document. To 
move several objects you must first group its.



To enlarge and to reduce of objects 

• Select one or several objects or groups.
• Activate the left mouse button on one of the blocks control points, and move the mouse.
• Release the mouse button.

To keep the proportions ob selected objects while enlarging or reducing:
• Proceed as it is explained above but with both left and right mouse buttons.
• Release the mouse buttons (left one first).

Others deformations:
 Sinusoïdal deformation
 Symmetry
 Rotation
 Skew tool
 Spherical and black hole projections



To delete objects 

• Select one or several objects or groups.
• Activate the Suppr key or the Delete command of the Edit menu.



To modify the contour of drawing objects 

To move path control points:
• Activate the left mouse button on a path control point.
• Move the mouse while holding the left mouse button down.
• Release the mouse button.

To insert a path control points:
• Select a single path with the left mouse button.
• Activate the tool corresponding to the type of point to insert (line, arc, spline...).
• Activate the left mouse button on a path control point (the cursor then looks like a cross).
• Move the mouse until the wished position..
• Release the mouse button.

To delete path control points:
• Select a single path with the left mouse button.
• Activate the left mouse button on a path control point (the cursor then looks like a cross).
• Activate the Suppr key 



Arrow tool 

Keyboard shortcuts: 'e', 'E', '9', Return key to activate consecutively Arrow tool and 
precedent tool.

Allows the selection, the moving and the resizing of objects and groups.

Allows the modification of contour of drawing objects by moving, inserting and deleting path 
control points.

To select objects
To move objects
To enlarge and to reduce of objects
To delete objects
To modify the contour of objects

See also:
To move the document inside the drawing window



Common properties of drawing tools

When a drawing object is selected:
1 Vincent shows the selection by displaying, at the four corners and on the sides, blocks 

control points allowing the deformation of the objects
2 When a single element is selected path control points also appear. These control path 

points can be moved or deleted (Suppr key). New control path points of different types 
(line, arc, spline...) can be inserted.
See: To delete or to insert a control path point

Path control points colour:
The option Color Ctrl points (when checked) of the Preferences dialog box allows the 
display of path control points with different colours according to their type:

• Line points in blue, 
• Arc points in green,
• Cubic spline points in red,
• Quadratic spline points in red,
• Bezier  points in violet,



Ellipse tool 

Keyboard shortcuts: 'q', 'Q', '4'.

Allows the drawing of ellipses or circles.

To draw an ellipse:
• Activate the left mouse button.
• Move the mouse.
• Release the mouse button.

To draw a circle:
• Proceed as for an ellipse while holding the Ctrl key down.

To modify, delete or move ellipses, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Rectangle tool 

Keyboard shortcuts: 's', 'S', '5'.

Allows the drawing of rectangles and squares.

To draw a rectangle:
• Activate the left mouse button.
• Move the mouse.
• Release the mouse button.

To draw a square:
• Proceed as for a rectangle while holding the Ctrl key down.

To modify, delete or move rectangles see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Rounded corners rectangle tool 

Keyboard shortcuts: 'd', 'D', '6'.

Allows the drawing of rounded corners rectangles.

To draw a rounded corner rectangle:
• Activate the left mouse button.
• Move the mouse.
• Release the mouse button.

To draw a rounded corner square:
• Proceed as for a rounded corners rectangle while holding the Ctrl key down.

To modify, delete or move rounded corners rectangles, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Arc tool 

Keyboard shortcuts: 'w', 'W', '1'.

Allows the drawing of elliptical arcs.

To draw an elliptical arc:
• Activate the left mouse button.
• Move the mouse.
• Release the mouse button.

Note: to draw a reverse arc, proceed as is explained above while holding the Ctrl key down.

To modify, delete or move elliptical arc, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Line tool 

Keyboard shortcuts: 'x', 'X', '2'.

Allows the drawing of lines and broken lines.

To draw a line:
• Activate the left mouse button.
• Move the mouse.
• Release the mouse button.

To draw an horizontal or a vertical line, or a line with a rotation step of 15°:
• Activate the left mouse button.
• Proceed as a normal line while holding the Ctrl key down.

To draw a broken line:
• Draw a line as is explained above.
• Insert a point from the last line point.

To modify, delete or move lines see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Cubic spline tool 

Keyboard shortcuts: 'c', 'C', '3'.

Allows the drawing of cubic spline.

To draw a cubic splin:
• Activate the left mouse button.
• Move the mouse.
• Release the mouse button.
• Insert new spline points from the last point .

Note: when the mouse cursor is situated near a spline control point, it then looks like a little
arrow indicating the direction of the segment joining the preceding and the next 
spline control point.

To modify, delete or move cubic splines, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Stars 

Keyboard shortcuts: '0', zero.

Allows the drawing of stars, polygon, rays, etc.
Click with right button to open the Star Manager dialog box.

To draw a Star:
• Activate the left mouse button.
• Move the mouse.
• Release the mouse button.

Using of the Star Manager dialog box:
• Options (Star, Polygon, Ray, Vincent):specify the type of object to draw. By default the

object is a star (with 8 branches). QSpline: this option creates Spline control points at 
least of line points

• Number of branches: specify the number of branches (for Star or Ray), or the number 
of sides (for Polygon or Vincent objects).

• Internal circle: specify the size of the internal circle (for the stars only) in percentage of 
the size of the star.

• Start angle: specify the rotation of the object to create. The buttons 0°, 30°, 45°... give 
automatically those standard values.



Quadratic spline tool 

Allows the drawing of quadratic spline.

To draw a quadratic splin:
• Activate the left mouse button.
• Move the mouse.
• Release the mouse button.
• Insert new spline points from the last point .

Note: when the mouse cursor is situated near a spline control point, it then looks like a little
arrow indicating the direction of the segment joining the preceding and the next 
spline control point.

To modify, delete or move cubic splines, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Bezier tool 

Allows the drawing of bezier curves.

To draw a bezier curve:
• Activate the left mouse button.
• Move the mouse.
• Release the mouse button.
• Insert new Bezier points from the last point .

Note: When the mouse cursor is situated near a Bezier control point, it then looks like a 
little arrow indicating the direction of the segment joining the preceding and the next 
Bezier control point.

To modify, delete or move cubic splines, see also:
Common properties of drawing tools
To select objects
To move objects
To enlarge or to reduce objects
To move, to delete and to insert path control points



Rotation tool 

Realizes a rotation of a single drawing object or a group.
• Select an object or a group.
• Activate the Rotation tool.
• Activate the left mouse button and move the mouse.
• Release the mouse button.

To modify or suppress a rotation:
• Select an object or a group previously submitted to a rotation.
• Activate the Rotation tool.
• The center of the rotation looks like a cross. Activate left mouse button and move the 

mouse to displace this center.
• To suppress a rotation, activate the Suppr key when the mouse cursor is located on the 

center of rotation (the cursor then looks like a big cross).

Note 1:by holding the Ctrl key down, at least to change the rotation for the selected object,
this object is duplicated.

Note 2:by holding the Shift key down during rotation, the rotation is realized according to a
15° step.
The Shift and the Ctrl keys can be used simultaneously.

Others deformations:
 Sinusoïdal deformation
 Resizing
 Symmetry
 Skew tool
 Spherical and black hole projections



Spherical and Black hole projections tool 

The Projections dialog box, allowing to choose either a Spherical or Black hole 
projection, is accessible by activating the right mouse button on the Projections tool.

Projections can be applied to one or several drawing objects and to groups.

To realize a projection:
• Select one or several objects or groups.
• Activate the Projection tool with the left mouse button (to change the type of projection, 

activate the right button).
• Activate the left mouse button on the center of the wished projection.
• Move the mouse.
• Release the mouse button.

To modify or suppress a projection:
• Select an object or a group previously submitted to a projection.
• Activate the Projection tool.
• Activate left mouse button on the center of the projection and move the mouse to 

displace the center of projection. Activate left mouse button on the circumference of the 
projection and move the mouse to modify the radius of the projection. 

• To suppress a projection, activate the Suppr key when the mouse cursor is located on the
center or on the circumference of the projection.

Others deformations:
 Sinusoïdal deformation
 Resizing
 Symmetry
 Rotation
 Skew tool



Skew tool 

Allows the realisation of skew effects on selected objects and groups.
• Select a drawing object or a group.
• Activate the Skew tool..
• Activate the left mouse button on the center of the wished projection.
• Move the mouse.
• Release the mouse button.

Others deformations:
 Sinusoïdal deformation
 Resizing
 Symmetry
 Rotation
 Spherical and black hole projections



Comet tool 

Allows the creation of sprayed of forms (circles, triangles, lozenges, squares) according to a 
freehand drawing.

• Activate the left mouse button.
• Realise a freehand drawing by moving the mouse.
• Release the mouse button.

To modify the parameter of a selected Comet, use the Comet dialog box accessible:
• by activating the Comet tool withe the right mouse buton,
• or by activating the Comet command of the popup Attributes menu.

Functioning of the Comet tool:
By creating a frreehand drawing, you can see appear little points on screen.The sprayed of 
form is generated around these points.
Slower the mouse moves, the more points there are.
The sprayed of form depends on several parameters::
- the Number of elements around each point.
- The Comet radius which define the scattering zone of element    (circles, triangles, 
lozenges, squares) around each point.
- The Points radius (in tenths of mm) define the size of the elemnts (circles, triangles, 
lozenges, squares).
Each of these parameters can increase or decrease, from the beginning to the end of the 
freehand drawing.
The elements (circles, triangles, lozenges, squares) can be put in rotation according to a 
Free angle.



Scissors tool 

Allows to cut a drawing object.

Method:
• Select a drawn object (Scissors tool allows selection)
• clic on a path contro point of the selected object.

Notes: the Join 2 lines command of the popup Attributes menu allows to join two paths.



Multi tool 

Allows the placing of symbols and clipart on a document. 

Activating Multi tool opens the Multi window containing all kinds of Vincent object. These 
objects are located in a file named Multi.teo.

Using the Multi tool:
• Activate the Multi tool. That opens the Multi windows which displays the active Multi 

object.
• Choose an object by activating the translator.
• Clic on the wished position to place the Multi object.

or
• Activate the left mouse button, move the mouse and release the mouse button to place 

the Multi object which then get the proportions of the mouse moving.

Add button add a selected object to the list.
To add several objects as a single Multi object, it is necessary to previously group them.

Suppr. button removes the visible object from the Multi windows.



Origin 

Located at the intersection of Horizontal and vertical rulers, the Origin tool allows to change
the location of the origin of the active document.

Method:
• Activate the left mouse button on the Origin tool,
• Move the mouse,
• Release the mouse button.

Rulers then display the new origin coordinates.

To place the origin at its original location, click with the right mouse button on the Origin 
tool.
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Menus 

File
Edit
Modify
Options
Attributes
Zoom
Windows
Help

Popup Attributes menu



File menu

The File menu contains commands that allow to begin a new document, to open and to 
save documents, to import and to export, to print, to setup the printer, and to leave Vincent.

New
Open...
Save
Save as...

Cliparts...
Template...

Import
Script...
Plotter... HPGL
Image... PCX

Image... BMP
Image... TGA
Metafile... WMF

Export
Metafile... WMF
Plotter... HPGL
Image... BMP
Postscript...PS

Print...
Contrel panel...

Exit

1, 2, 3 .. File name



Edit menu

The Edit menu contains commands that allow to cancel, to delete, to copy    and to paste 
objects and styles and to select all.

Undo
Redo

Delete

Cut
Copy
Paste
Paste Special
Duplicate

Copy style
Paste style

Select all



Modify menu

The Modify menu contains commands that allow to modify elements.

Group
Paving
Ungroup

        Edit  
Information...

Arrange
Align

Symmetry

Assemble
Disassemble

Sinusoïd...
Blend shapes...

        Join on a path...  
        Split text  
        Mask  



Options menu

The Options menu contains commands that allow to serup rulers, grids and the size of the 
document, to modify preferences, to display or non colour palette and rulers, to make guides
active or inactive, visible or invisible, and to access directly to external programs.

Grid...
Page configuration...
Preferences...

Palette colour
Rulers
Toolbars...
Guides

Quick display
Display bitmap

External programs



Attributes menu

The Attributes menu contains commands that allow to modify attributes of text, drawing 
and quotation, to modify and to create new colours, to create gradations, to access to the 
Keyboard utilitarian, to manage layers, to modify the style of lines.

Text...
Drawing...
Quotation...
Colour...
Gradation...
Keyboard...
Layers...
Line

popup Attributes menu:
Attributes menu can be easily attainable clicking with right mouse button inside active 
document window.



popup Attributes Menu 

Attainable easily by clicking with right mouse button inside active document window.

In addition with common Attributes menu commands, this popup menu has (depending on
circumstances) the following commands:

• Group Groups objects in a single object if more than one object 
are selected.

• Ungroup Ungroups when a group is selected.
• Edit Edit a text or a paving if one is selected.
• Font Displays a popup menu which allows to change a selected 

Vincent text font. If a quotation is selected: display the 
standard Windows Fonts dialog box to modify quotation 
text attributes.

• Close: Does the same thing as Closed check box of Drawing 
attributes dialog box. Closes selected path(s).

• Open Like above, opens selected path(s).
• Join 2 lines Joins to differents paths creating a line between the last 

point of the first element and the first point of the second 
element.

• Assemble Assembles selected objects.
• Disassemble Disassembles a selected object (previously assembled).
• Edit paving Opens    Paving dialog box.
• Blend shapes... Appears when 2 vectorial elements with the same number 

and types of control points are selected. This comand opens
the Shapes gradation dialog box.

• Split text Converts Vincent text into drawing pathes.
Note: a copy of original text is kept over new elements.

• Edit Bitmap Displays a submenu with names of avalaible bitmap 
program. Select any of these programs to edit selected 
bitmap.

• Join on a path... Opens the Join with a path dialog box.
• Comet Opens Comet dialog box when a comet object is selected.
• Scale... Opens Quotation scale dialog box when a quotation line is 

selected.
• Remove quotation Removes all parameters of a selected quotation.
• Undo horizontal symmetry Undoes horizontal symmetry assigned to a Vincent text 

or a group.
• Undo vertical symmetry Undoes vertical symmetry assigned to a Vincent text or a 

group. 
• Delete transformations Undoes all transformations assigned to a Vincent text or a 

group. 
• Edit drive surface Opens    Bézier Surface dialog box.



Zoom Menu

The Zoom menu contains commands that allow to enlarge or to reduce the display of 
elements contained in the active drawing window.

 Fit on screen (F9): displays either the most important part of the document, (if possible
all the document) or zoom with a 100% rate.

 On selection (key /): zooms to display selected elements.

100 % .. 800%: zooms for these rates.

Full screen (F8): displays visible part of the active document on all screen area (without 
menu and so on).



Windows menu

The Document menu contains commands    that allow to organize drawing windows present
on the screen.

Cascade      Shift + F5  commands: Piles drawing windows. It is the organization 
proposed by defect.

Tile      Shift + F4  command: reorganizes the display of drawing windows in mosaic, 
such sort that they do not cover.

Arrange icons command Reorganizes icons corresponding to the drawing windows by 
aligning them at the bottom of the main window.

Close all : Closes all drawing windows present on the screen.



Help menu

Index command: Opens the help of Vincent system and displays the contents page.

Topic search command: displays the help cursor    with which select the option of menu or 
the tool in order that you desire to obtain information. Activate twice to cancel the 
command.

Using Help command: displays the assistance module of Windows, winhelp.hlp, giving 
information on the use of the help system.

Info bubbles command: If the checkmark ( ) is visible, the Info bubbles are displayed 
when moving the mouse over the toolbars.
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New command File menu         
Begins a new document

Keyboard shortcuts: Ctrl + N.

The new document has the name 'Noname' until you record it under an other name (Save 
as    command of File menu).



Open... command File menu         

Opens a dialog box (files selector) allowing to load a Vincent document that has been 
previously created.

Keyboard shortcuts: Ctrl + O.

Enter or select the name, directory and disk of file that you want to load.

Enter the extension '.TBK' if you want to restore a version previously saved of a file.

Note: Vincent makes a saving copy of a file if the option Saving copy is checked in the 
Preferences dialog box. Saving file has '.TBK' extension.



Save command File menu        
Opens a dialog box    allowing to save the active document to disk.

If you use an existing file name, Vincent asks if you want to overwrite the existing file.

The FileISave command saves the file in the active edit window to disk.

If the file has a default name (Unnamed.TEO), Vincent opens the File Save As... dialog box 
so you can rename the file and save it in a different directory or drive.

Note: Vincent makes a saving copy of a file if the option Saving copy is checked in the 
Preferences dialog box. Saving file has '.TBK' extension.



Save as... command File menu        
Saves the active document to disk.

Enter or select the name, directory and disk of the file that you want to save.

Note: Vincent makes saving copy of a file if the option Saving copy is checked in the 
Preferences dialog box. Saving file has '.TBK' extension.



Clipart... command File menu        
Opens    Clip-Art dialog window.
Clip-Art dialog window enables to choose predefined objects in clipart library and to place 
objects from that library into your document.

Use of the Clip-Art dialog window:
• Left list contains all the words linked to clipart.
• To click on a word displays inside the right list associated words and topics, themes, 

subjects....
• To click on the See button (or to double-click a word of the left list) displays a reduced 

view of the document containing the associated clipart(s).
• To double-click an object of the reduced view pastes the object into the document
• To click the Open button opens the files containing the associated clipart(s).



Template... command File menu        
Opens the Vincent - Template dialog box.

This dialog box allows to use Vincent files as templates, to load and to visualize those files.

The selected file are shown on the right. Vincent search first a bitmap file or a WMF file and 
if    not the Vincent file (with ".TEO" extension).

The list Choose a template contains the names of Vincent files to be used as templates.

The button Open template opens the file selected.

The button New document closes the Vincent - Template dialog box and creates a new 
document.

The button Open file... closes the Vincent - Template dialog box and opens the File open
dialog box to open a file..

The button Add... opens the File open dialog box to add a new template to be added to the
list of templates.

The button Del... removes from the list of templates the selected file.

The button Close close the Vincent - Template dialog box.



Import Script TXT command File menu
Opens    the File open dialog box where you specify the name of a script file with '.TXT' 
extension to open.

This command enables Vincent to read an Ascii file containing the description of vector 
arrays. Vincent displays into the active drawing window the objects corresponding to that 
description.

- See the 2 examples : Etoile.txt et Sinus.txt, generated by programs Etoile.pas and Sinus..
- Pascal or any other language can be used to generate such text files.
- Separators < > or    <,> or <;> between datas.



Import Plotter HPGL command File menu         
Opens    the File open dialog box where you specify the name of a HPGL file with '.PLT' 
extension to open.

 Vincent opens then the HPGL Import dialog box allowing to select several options:
• Close shapes: the polygons are closed (and    therefore coloured with the active colour).
• Invert X & Y axis: axes are inverted in X and Y.    
• Line thickness by colour: Vincent creates thickness of contour according to the colour

of the contour.

Notes:
1 - Vincent read in HPGL files:    thicknesses of line, texts, colours, respect of the
HPGL coordinated.
2 - Drag and drop of HPGL file from the File manager of Windows



Import Image... PCX command File menu        
Opens    the File open dialog box where you specify the name of a Bitmap file with '.PCX' 
extension to open.

Note: Vincent imports monochromes PCX, 256 colors type 5 and 16,7 M color type 5.



Import Image... BMP command File menu        
Opens    the File open dialog box where you specify the name of a Bitmap file with '.BMP' 
extension to open.



Import Image...TGA command File menu        
Opens    the File open dialog box where you specify the name of a Bitmap file with '.TGA' 
extension to open.

Note: Vincent imports compressed and uncompressed 24 bits TGA bitmaps (type 2 and 
10 ).



Import Metafile... WMF command File menu        
Opens    the File open dialog box where you specify the name of a file with '.WMF' 
extension.



Export Metafile... WMF command File menu         
Opens the File Save As    dialog box where you specify the name of a file.
 
The selected objects of the active windows are saved with Windows Meta File format into 
this file.



Export Plotter... HPGL command File menu         
Opens the File Save As dialog box where you specify the name of a file.
 
The selected objects of the active windows are saved with HPGL format into this file.



Export Image... BMP command File menu        
Opens a dialog box where you specify the name of a file, to save with BMP format selected 
objects.



Export Postscript... PS command File menu        
Opens the dialog box Postscript Export allowing to select several options for exporting 
active document as Poscrtcript file format.:

Options
• Quadri Separation: with this option Vincent generates a Postscript file allowing to 

obtain one or several films. The selection of this option makes available the two next 
options. 

• Negative: to realize negative films.
• Offset direction: the document is inverted as if you looked by transparency through 

the printed page.

Colours
• Each option Cyan, Magenta, Yellow and Black, corresponds to a film. Values indicated

beside these options correspond to the orientation of the screen ruling. Different 
orientation for each film allows to avoid moirage effects. 

• Screen ruling: for a laser printer of office, use a screen ruling of 60.
• Selection: to export only selected objects.
• All: to export the totality of the document.
Note: invisible plans remain invisible (no exported), with plans in rapid display only 

contours are exported.
• On port: send directly the Postscript file to your Postscript printer or other Postscript 

peripheral (connected to this port).    The button Port allows to select the port.
• On file: option to generate a Postscript file with the '.PS' extension.

Once you have selected and modified the Postscript export options, activate OK.button. 
Vincent opens then the Save as dialog box where you specify a file name

Notes on the Postscript export.
Are not exported:
• Windows bitmaps, (excepted 24 bits DIB, 24 bits TGA and monochomes PCX).
• Metafiles.
• Periodic effect in gradations
• Assembled drawings containing too many points.



Print... command File menu        
Prints the document corresponding of the active drawing window.

Keyboard shortcuts: Ctrl + P.

Opens the Printing dialog box allowing to setup and to launch the printing of the active 
document.
The scale of the printed document can be other than 100%. The size of the document can be
adjusted to the page size. The impression of a document can be realized on several pages 
with or without a margin of recovery.
It is possible to change the printer, to print several copies of the document, to setup the 
printer, to print crop marks and registration marks, to print only the selection, to print in 
rapid mode, to centre the printing on the page, to print the name of the document, the date,
the time and the scale of printing.

Using the Printing dialog box:

Scale
100%: it is the scale of printing by default.
Defined: check this option to print a document to an other scale than 100%.
Fit on paper:    check this option to adapt the scale of the document to make it hold on a 
single page.
Notes: This option is useful to print a document larger than the format of impression.

The size of this document has to have been setup (Page configuration... 
command of Options menu) to a different format (for example A3 or A5) of the 
format of impression (for example A4).

Overlap: to indicate in the case of the impression of a document on several pages 
(Defined option) a margin of recovery in millimeters.

List of printers
It is a combo box associating an editing zone indicating the name of the active printer and 
the list of available printers.
By Selecting a printer of the list or by giving its name in the editing zone, this printer 
become active.
By default the active printer is the same than that selected with the Windows Printer 
setup dialog box.

Copies
Indicate here the number of printings wished.
By default Vincent prints one copy of the document.

Printer configuration button
Opens the Windows Printer setup dialog box.
This dialog box allows configuration of the active printer.

Options
Crop marks: prints horizontal and vertical marks to extremities of the document. Allows to
cut the document after impression or to visualize the true format.
Registration marks: prints marks to the exterior and to mi - distance of horizontal and 
vertical extremities (for example transparent or offset films). This option is accessible when
Crop marksoption is selected.
Selection: prints only the selected elements of the active drawing window. This option is 
checked by default if elements are selected.



Fast: realizes a rapid printing. There are printed only the contours of drawings without 
filling colors, hatched rectangles instead of of bitmaps, grayed rectangles instead of 
Windows texts . A Fast printing is identical to the display obtained with the command 
Quick Display of the Options menu.
Center on paper: centers the document on the printed pages.
Name+Date: prints the name of the file, the date and the time of the system at the 
moment of the printing, the scale of printing if it is different than 100%.

Activate the Ok button to launch the printing.

A zone of dialogue appears allowing you to cancel the impression by activating the key Esc 
or the Cancel button.

See: Contrel panel...



Control panel... command File menu        
Opens Windows Control panel.

To change default printer or to modify printer setup, activate Printers icon.

Important: 
- changing paper size modifies the size of the document into Vincent, if the option Printing
area of the Page configuration dialog box is checked.

Note: Vincent can display a document to the maximum size of 51 cm X 51 cm



Exit command of File menu        
Quit program.

Close all documents windows and propose (if it is not done) to save files.



1, 2, 3 .. File name command of File menu
Open one of the last files previously open or saved.

The command 1.    .    File name opens the last opened file; the command    2.    .    File
name opens the second last opened file, etc.

The number of files thus accessible is modifiable in the configuration file
Vincent.ini.
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Undo command Edit menu        
Cancels the last modifications of the active document. 

Keyboard shortcut: Alt + BkSp (Backspace)

Undo command functions on several levels: it allows to cancel up to 9 actions for active 
layer. When you change the active layer you can no longer cancel actions of the preceding 
layer.
The number of levels can be modified (1 to 9) in the Preferences dialog box 

Vincent asks you to confirm the cancellation by indicating your precise action.

Note: Redo command of the Edit menu cancels Undo command.



Redo command Edit menu        
Remakes actions previously cancelled by the Undo command.

Keyboard shortcut: Shift + Alt + BkSp (Backspace)

Similar functioning to the Undo command.



Delete command    Edit menu        
Delete selected objects.

Keyboard shortcut: Del



Cut command Edit menu        
Deletes selected objects and places its in the clipboard.

If nothing has been selected, this command is not available.

Keyboard shortcut: Shift + Del.

Notes: Vincent places in the Clipboard 2 versions of selected objects, one vectorial 
(you can paste into Write or    Winword for example) and the other bitmap (you can 
paste into Paintbrush for example).
- the Preferences dialog box allows to place in the Clipboard one of these two 
formats or both.

- the Clipboard  contains two commands Mode point and Image, for versions 
respectively bitmap and vectorial.



Copy command Edit menu        
Copies selected objects in the clipboard.

Keyboard shortcut: Ctrl + Ins.

If nothing has been selected, this command is not available.

See notes of the Cut command of Edit menu.



Paste command Edit menu        
Inserts a copy of the content of the clipboard in the active drawing window.

Keyboard shortcut: Shift + Ins.

You can paste Bitmap objects and vectorial objects (metafile) previously placed    in the 
Clipboard with the Copy command of the Edit menu of Vincent or an other program.

See:
• the Clipboard  contains two commands Mode point and Image, for versions 

respectively bitmap and vectorial.
• the Preferences dialog box.



Paste special command    Edit menu        
Opens a dialog box Paste special allowing the choice among one of the
formats contained in the clipboard.

See:
Paste and Copy commands of Edit. Menu.



Duplicate command Edit menu        
Duplicates selected object(s)    and displays this copy beside original object(s) (1cm to right, 
1 cm down).

Keyboard shortcut: Ctrl + X.



Copy style command Edit menu        
Copies the style of a selected object.

To allocate a style, activate the Paste style command of the Edit menu.



Paste style command Edit menu        
Allocates to a selected object, the style copied.



Select all command    Edit menu        
Selects all the content of the active drawing window.

Keyboard shortcut: Ctrl + T.



Group command Modify menu        
Regroups selected objects in an alone element.

Keyboard shortcut: Ctrl + G.

It is useful to group elements:
• to deform objects together,
• to fix the position of elements between them.
• to select easily an element without risk of deforming it.

Note: the Group command places the group, therefore elements that compose it, in the 
forefront.
A group can be displaced behind or in front of the screen with the Arrange 
command.

If nothing has been selected, or if an single element has been selected, the command is not 
available.

It is possible to group several groups in an one: select several groups and execute the Group
command.

To separate grouped elements, execute the Ungroup command.

To group identical elements, use Paving command. With the Paving command, Vincent 
uses and saves only one element: files are more compact on disc, more rapidly loaded and 
occupy lesser place in memory.



Paving command Modify menu        
Realizes a paving (distribution) of a selected object inside a defined zone.

Keyboard shortcuts: Ctrl + V.

It is possible to pave all kinds of objects: paths of drawing as bitmap or texts.

Method:
• Select the object.
• Activate the Paving command.
• Enlarge the element by displacing its block control points while activating Shift key. The 

enlarged block is then paved with the number of elements that it can contain.

A Paving dialog box allows you to modify paving attributes. This dialog box is accessible by 
the Edit command of    the Modify menu to or the Edit paving command of the popup 
Attributes menu    when a paving is selected.

Note 1: to modify the size and proportions of a paving, and therefore to modify the size and 
proportions of the basic element, displace as usual its block control point (without 
activating Shift key).

Note 2: with the Paving command, Vincent uses and saves only one element:files are more 
compact on disc, more rapidly loaded and occupy lesser place in memory.

Note 3: the Ungroup command applied on a paving undoes the paving and restores the 
basic element.



Ungroup command    Modify menu        
Restores components (graphic elements or subgroups) of a group.    

Keyboard shortcut:    Ctrl + S.

Applied on a paving, the Ungroup command cancels the paving and restores the basic 
element.

If no group has been selected or if several groups have been selected, the command is not 
available.



Edit command Modify menu        
Keyboard shortcut: Ctrl + E

Open:
*-a line editor if selected object is a Vincent text.
*-a text editor if selected object is a Windows text.

*-the Paving dialog box if selected object is a paving. 



Information... command Modify menu        
Displays the Info window giving information on a selected object.

Keyboard shortcuts: Ctrl + I.

X: and Y: indicate coordinates of high and left edges of the selected object
X': and Y':    indicate coordinates of low and right edges of the selected object.
L:    and H:    indicate the width and the height of the selected object.
MM, CM, Inch and 1440e display X, Y, X ', Y', L and H values, respectively in millimeters, 
centimeters, inches and 1 / 1440 of Inches.
Colours: indicates colours of contour, filling and gradation with their RGB component, 
respectively red, green and blue.

Also indicated according to the selection:
• for a vector drawing:

- the open state (contour only) or closed (object coloured), (See drawing attributes.
- the control path point number .

• for a Vincent text :
- 5 first characters of the text,
- the font, the size (in points) and the width of the text. 
• for a bitmap:
- the size (width X height)
- the number of bits per pixel. 1 bit = bitmap 16 colours, 8 bits = bitmap 256 colours, 24 

bits = bitmap 16,7 M colours.



Arrange command Modify menu         
 
 

Moves above, below, in the foreground or in the background selected object(s) and/or 
group(s).

Background: moves the selected object(s) to the background.
Keyboard shortcut: Ctrl + Shift + R

Above: moves the selected object(s) before the element following the first element 
of the selection. If several elements have been selected, places the selection befor the 
element following the first element of the selection.
Keyboard shortcut: Ctrl + Shift + D.

Below: moves the selected object(s) behind the preceding element. If several 
elements have been selected, puts the selection behind the element following the first 
element of the selection.
Keyboard shortcut: Ctrl + Shift + E

Foreground: moves the selected object(s) in the foreground.
Keyboard shortcut: Ctrl + Shift + P

Note: the Group command places the group, therefore the elements that compose it, in the
foreground. In cases where many elements have to be judiciously arranged, use 
Layers control dialog box functions.



Align command Modify menu         
 
 
 
 

Align selected object(s).

Top: aligns the summit of selected object(s) on the top of the selection.

Bottom: aligns the base of selected object(s) on the bottom of the selection.

Right: aligns the right edge of selected object(s) on the right edge of the selection.

Left: aligns the left edge of selected object(s) on the left edge of the selection.

Centre Horizontal: aligns selected object(s) according to their respective horizontal 
centres.

Centre Vertical: aligns selected object(s) according to their respective vertical centres.



Symmetry command Modify menu         

Horizontal:applies to selected objects a horizontal symmetry.

Vertical: applies to selected objects a vertical symmetry.

The command Symmetry can be applied to bitmap elements.

To undo a symmetry, use the inverted symmetry except for a Vincent text
 or a group: in these 2 cases, activate command Undo horizontal
symmetry or Undo vertical symmetry of the Attributes popup menu.



Assemble command Modify menu        
Assemble selected objects in a single object.

For an example, the character A constitutes an assembled form, constituted originally of the 
external contour and the small internal triangle.

Keyboard shortcut: Ctrl + Shift + A

Method:
• Apply a colour to each elements (to close them).    
• Select elements (successive selection by keeping the key Shift down or by drawing a 

selection rectangle).
• Activate the Assemble command.

Note: The obtained element can be modified as the other Vincent's drawing elements: you 
have its control points.



Disasemble command Modify menu        
Disassemble an element beforehand assembled.

Method:
• Select object to disassemble.
• Activate the Disassemble command.

Note: Obtained elements find all properties that they had before to be assembled.

 



Sinusoïd... command    Modify menu        
Applies to one or several selected objects or groups a sinusoïdal deformation.

Opens the dialog box Sinusoïd.

Using the Sinusoïd dialog box :
A zone allows to visualize a sinusoïdal projection applied on a rectangle having the same 
proportions of the selected sinusoïdal object(s) and corresponding to parameters given. 
These parameters are:

1 - the frequency of the sinusoïd, allocated by the horizontal translator:    it can vary from 
Pi / 2 to 10 Pi by of Pi / 2.

2 - the amplitude of the sinusoïd (vertical translator).    
3 - the symmetry of the deformation with the check box Sym.



Blend shapes... command    Modify menu        
Opens the dialog box Shapes gradation which allows to generate intermediate elements 
between two drawing elements realized with Vincent drawing tools.

Method:
• Realize two elements. The two elements have to have the same control points number 

and to have been realized with the same drawing tools. Elements can be composed of 
different types of points (arc, line, spline), but the same number in the same order.
The simplest way is to duplicate an element and to deform one of the two elements. 

• Select the two elements.
• Activate the command Blend shapes...
• Indicate in the dialog box Shapes gradation the number of wished intermediate 

elements (between 3 and 300).
• Activate Ok button.

Notes: 1 - The gradation is applied both to the shape of elements and to their filling and 
contour colours.
2 - The objects generated with the Blend shapes feature are grouped.



Join on a path... command Modify menu
Opens the Join with a path dialog box.

This dialog box allows to align a group of objects along a path (a drawing realized with the 
Vincent tools, line, spline, etc.).

First create the objects you want to see aligned with a pah.
For example :
• create a drawing objects ( with the vincent drawing tools) and then duplicate it and use 

the Blend shapes features to obtain a group of objects.
• or create a Vincent text then split it and group the characters.
• or draw any quantity of different objects.

Then draw a path with the Vincent drawing tools, like line, spline, bezier, etc.
Select both the group of objects and the path and then activate the command Join on a 
path which opens the Join with a path dialog box.. The Join on a path command is then 
accessible by the popup Attributes menu.

Using of the Join with a path dialog box:
Options:
• Rotation: puts the objects in rotation according of the direction of the path.
• Keep the distances: keeps the distance betwwen the objects.
• Start: align the objects from the begining of the path.
• Center: align the objects on the center of the path (if the path is longer than the objects).
• End: align the objects at the end of the path.
Base: specify which part of the objects is aligned with the path (by default the center).



Split text command Modify menu
Converts Vincent text into drawing pathes.

Notes:
• the Split text command is on the popup Attributes menu when a Vincent text is 

selected. .
• a copy of original text is kept over new elements.
• splited text can be joined on a path:

• - group the letters,
• - create a path,
• - select both the group of letters and the path and activate the join on a path command.
• - select on the Join with a path dialog box the left and bottom radio button for the 
Base attribute.



Mask command Modify menu
Mask a bitmap inside a drawing object or a Vincent text . The bitmap is then solely visible 
inside the drawing object or the Vincent text.

Method:
• Select a drawing object (created with the Vincent tools: line, arc, spline, ellipse, 

rectangle) or a Vincent text and a bitmap.
• Activate the Mask command.
The bitmap appears only inside the drawing object.
Notes:

• The drawing object has to be closed, check the Closed option if necessary (Drawing... 
dialog box or Closed command of popup Attributes menu.

It is possible to mask other objects (drawing elements, bitmap, group, Vincent text, 
paving...) inside a drawing object or a Vincent text using the Mask option of the Drawing 
dialog box.

The Mask attribute can be given to:
• a drawing path (created with the Vincent tools: line, arc, spline, ellipse, rectangle),
• a Vincent text

Method:
• Select a    drawing object or a Vincent text .
• Allocate to this element the Mask attribute by checking the Mask option of the Drawing 

dialog box (Drawing... command Attributes menu).
• The element has to be closed, check the Closed option if necessary (Drawing... dialog 

box or Closed command of popup Attributes menu.
• Group (Ctrl+G) this element with one or several other elements (drawing elements, 

bitmap, group, Vincent text, paving...).
The other elements appear only inside the element that has the Mask attribute.



Fin v_menu3



Close command popup Attributes menu 
Closes a selected element and applies it the active colour (last colour selected in the colour 
palette). 

Note: do the same thing as 'Closed' checkbox (activated) of the Drawing attributes dialog
box.



Open command popup Attributes menu 
Opens a selected element and removes it its colour.

Note: do the same thing as 'Closed' checkbox (inactivated) of the Drawing attributes 
dialog box.



Font command popup Attributes menu 
Displays a submenu indicating the name of all available Vincent fonts.
Click on a font name to allocate this font to the selected Vincent text.

To modify the font of a Windows text:
• select a Windows text,
• use the Edit command of Modify menu.



Line command popup Attributes menu 
Opens a submenu allowing to apply a line style to a selected object.



Grid... command Options menu        

Keyboard shortcut: Ctrl + Shift + G

Opens the grid dialog box allowing to configure, modify, activate or desactivate the grid.

The visual grid
Serves as visual mark It is constituted of dots.
Modification and configuration of the visual grid:

• Activate Visible checkbox to display the grid.
• Enter values in millimeter in Step X and Step Y.

Magnetic grid
Allows to precise size or move objects by forcing object edges to land on snap grid dots 
positions.
Modification and configuration of the magnetic grid:

• Activate Active checkbox to activate the magnetic grid.
• Enter values in millimeter in Step X and Step Y.



Page configuration... command    Options menu        

Opens the Page configuration dialog box allowing to modify size and orientation of the 
active document, to define the colour of paper (background) and to configure printer.

Printing area: gives the document the format of the printable surface of the paper as it is 
configured in the Printer section of the Windows Control panel.

Next options give to the document, for a Portrait orientation, sizes (horizontal X vertical) in 
mm:

A5: 148 X 210
A4: 210 X 297
A3: 297 X 420
B5: 182 X 257
B4: 250 X 353
Tabloid: 279,4 X 431,8
US Letter: 215,9 X 279,4
US Legal: 215,9 X 355,6

Other: indicate in zones 'X:' and 'Y:' values wished in millimeters, horizontal and vertical 
respectively.

Entered values have to be between 1 mm and 520 mm.

Portrait and Landscape give the document vertical or horizontal orientation.

Colour: attributes to the bottom of the document a colour corresponding to the colour of 
paper used for printing (this colour is not printed, it allows to visualize the final document).

• click with the left mouse button on the Paper colour zone to open the popup palette and
click again with the left    button on the wished colour 

or
• click with the left button on the wished colour of the palette,
• maintain the button down by displacing the mouse until the Paper colour zone (the 

cursor resembles then a pot of paint),
• release the mouse button.

Printer options...: opens the Printer setup dialog box to set configuration options for the 
current printer.



Preferences... command Options menu        

Opens tne Preferences dialog box.

Preferences concern options for saving, displaying, clipboard, the
number of undo levels, the definition of line thicknesses and the choice
of units for the display of the rule, the coordinate and the grid.

These preferences are saved into the Vincent.ini file configuration.

Saving
Compressed saving:

Activates or desactivates compressed saving of Vincent files.
File loading take more time, but files are more compact.

Saving with palette:
If this option is selected, Vincent saves the palette with the drawing. The palette will be 
then loaded with this drawing.

WMF saving:
If this option is selected, Vincent saves (when using Save or Save as.. command of File 
menu) two files. One is the ordinary Vincent file with '.TEO' extension; the other is a 
metafile file format with '.WMF' extension.

Saving copy:
If this option is selected, Vincent saves (when using Save or Save as.. command of File 
menu) a saving copy with '.TBK' extension.

Sélector Win 3.1:
If this option is selected, Vincent uses standard Windows 3.1 dialog boxes to open and 
save drawings.

Display
Status line:

Activate or desactivate the status line.
If this option is selected, the status line is present.

Color Ctrl points:
If this option is selected, the control drawing points are displayed with different colours 
according with their type: line points in blue, arc points in green, spline points in red.

Fast gradation:
If this option is selected, the gradations are displayed in rapid mode with a limited 
number of steps. The display is thus more rapid. 
This option does not modify the impression of the gradations. Gradations thus preserve 
the attributes allocated in the Gradation dialog box.

Fast movings:
If this option is selected, objects do not display their contour but only a rectangle during 
displacement. Displacements are then more rapid.
By activating both right and left mouse buttons during displacement, elements display 
their contour.
If this option is not selected, the functioning is inverted and elements displaced with only
the left mouse button display their contour.

256 colors palette:
If this option is selected, Vincent manages a pure colour palette. Use this option if you 
use a mode of display in 256 colours.

Fixed palette:
Activates or desactivates the fixed palette.
If this option is selected, the fixed palette is present.

Blue frame:



Activates or desactivates the displaying of a blue frame around the page.
If this option is selected, the blue frame is displayed.

Progression bar:
Activates or desactivates the progression bars on the bottom of the main Vincent 
window.
If this option is selected, the progression bars are displayed, indicating the programm is 
working.

Small Ctrl pts:
Activates or desactivates the display of small points at the corner of each element inside 
a group.
If this option is selected, the small control points are displayed.

With Rectangle:
Activates or desactivates the display of rectangle(s) (at least of the contour) when 
dispacing object(s).;
If this option is selected, rectangle(s) are displayed.

Large palette:
Activates or desactivates the big palette window    in replacement of the little one.
If this option is selected, the big palette is displayed.

Large tools:
Activates or desactivates the big tools window    in replacement of the little one.
If this option is selected, the big tools are displayed.

Frame Win-Text:
Activates or desactivates the display of a frame around Windows text when not selected..
If this option is selected, the frames are displayed.

Clipboard
Copy Bitmap:

If this option is selected, Vincent puts a bitmap format version of selected objects into 
the clipboard when the Copy or the Cut command of Edit menu is activated.

Copy Image (metafile):
If this option is selected, Vincent puts a metafile format version of selected objects into 
the clipboard when the Copy or the Cut command of Edit menu is activated.

Undo levels
From 0 to 9 undo levels available. Possibility to undo up to 9 actions.

Line...  
 
 

Opens the Line thickness dialog box allowing to configure 4 line thicknesses (in tenths of 
millimeter) accessible by the Toolbars. 

 
 
 
. 

Units...
Opens the Units dialog box allowing to choose a unit (millimeter or inch) for the display of 
rulers and for the display of the coordinates and the surface on the status line.



Palette colour command Options menu        
Displays or removes the floating palette.
If the checkmark ( ) is visible, the floating palette is displayed.



Rulers command Options menu        
Displays or removes the rulers.
If the checkmark ( ) is visible, the rulers are displayed.



Toolbars... command Options menu        

Opens the Toolbars configuration dialog box.

Toolbars are constituted of icons. 
An icon is quicker to use than the corresponding menu command.

The Toolbars configuration dialog box allows to activate, configure and position the 4 
toolbars.

Any icon can be integrated in one of the 4 toolbars.

Using the Toolbars configuration dialog box:
The upper list represents available icons, those that are not present in any toolbars..

The lower list represents icons allocated to the selected toolbar(1, 2, 3 or 4).

Each line of these lists represents an icon and the description of the action that is allocated 
to this icon.

To add or insert an icon into a bar:
• select an toolbar activating one of four radio buttons, 1, 2, 3 or 4.
• select an icon in the above list, clicking on a line.
• Elements Spaces and Half-Space allow to place spaces to constitute groups of icons.
• activate Add or Insert button.

To remove an icon from an toolbar:
• select a toolbar activating one of four radio buttons, 1, 2 , 3 or 4.
• select an icon in the lower list, clicking on a line.
• activate Remove button. The selected icon is integrated in the upper list of available 

icons. 

To position a toolbar, on top, left or right:
• select an iconbar activating one of four radio buttons, 1, 2 , 3 or 4.
• select a position Top, Left or Right.
Note: it is possible to get up to four toolbars on the left or on the right, only one on top.

To remove all toolbars from screen:
• activate Active checkbox..



Guides command Options menu
A guide is created by pressing mouse button in rules, by displacing the mouse, then by 
letting go of the mouse button to the place wanted.

If the magnetic grid is activated, guides are moved according to the step of magnetic 
grid.

See: Using guides: To position, displace or remove guides...

The Guides command activate a submenu including the following commands:
• Visible: when the checkmark ( ) is visible, guides are displayed.

• Active: when the checkmark ( ) is visible, guides are actives (and attract the 
mouse).
• Create: automatically creates guides around a selected element (or the first element
of a selection). A horizontal guide and a vertical guide are created for each point (line, 
spline, arc) of the contour of the element.
• Delete: delete all guides after asking confirmation.

Notes: guides are saved with the document.



Using Guides

To place a guide
• by holding the left mouse button down in horizontal or vertical rulers to obtain an 

horizontal or a vertical guide..
• displace the guide to the wished position.
• release the mouse button.
Notes:
• If the magnetic grid is activated, guides are moved according to the step of magnetic 

grid..
• by pressing Ctrl key during displacement, the guide is moved according to a step of 1 

mm (even if the magnetic grid is activated).
• by pressing Shift key during displacement, the guide is moved without using the step of 

the magnetic grid (even if the magnetic grid is activated).

To displace a guide:
• activate the left mouse button on the rulers at the position of a guide..
• displace the mouse.
• release the mouse button.
Ctrl and Shift keys can be used as is explained above.

To delete a guide:
• activate the right mouse button in rules in the position of a vertical or horizontal guid.

To delete all guides:
• activate the subcommand Delete of the Guides command of Options menu.



Quick display command Options menu        
Puts in rapid display or in normal display all elements of the active drawing window.

When the checkmark ( ) is visible, all elements are in rapid display.

This command allows to get a faster display on screen:
• Drawing elements and Vincent texts display only their contour.
• Windows texts display grayed rectangles for each line of text.
• Bitmap objects display streaked rectangles.



Display bitmap command Options menu        
Display bitmaps or streaked rectangles instead of bitmaps to get a faster display.

When the checkmark ( ) is visible, criss-crossed rectangles are displayed instead of 
bitmaps striés (on screen and also on printing)..



External programs commands Options menu
External programs can be executed directly from Vincent modifying the configuration file 
Vincent.ini located into the Windows path.

Example: 
[Program]
1=&Drive Surface..., c:\vincent\Bzsurfac.exe
2=&Clipboard..., c:\windows\Clipbrd.exe
3=&NotePad..., c:\windows\Notepad.exe
4=&Vincent.Ini..., c:\windows\Notepad.exe c:\windows\Vincent.ini

For each of the 4 lines of that example, Vincent creates a new command in the Options 
menu. 
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Drawing path
Graphic element created with the Vincent tool: Ellipse, Rectangle, Rounded corners 
rectangle, Arc,, Line, Cubic spline, Quadratic spline, Bezier.
A drawing path is constituted of control path points that appear when a drawing object is 
selected. Cntrol path points of different types (line, arc, spline...) can be inserted on a same 
path.
A drawing path has a beginning and a end: the beginning has a control path point smaller 
than others.



Gradation angle
Angle indicated the direction of gradation.



Group
Object consitututed of different elements of any kind. A group can contain groups.



Attributes
Parameters given to an element. For a drawing objects attributes are for example the colour 
or the thickness of contour. For a text attributes are the font or the size of characters.



Duplicate
Action to make a copy of an object.



Element
All object that can be included inside a Vincent document: drawing object, text object, 
bitmap object...



Iconer
Graphic icon editor EGA/VGA for DOS programmers in Turbo Pascal. Supports mouse and 
scrolling menus. A unit allows to insert icons inside Turbo Pascal source code. In France the 
registration fee is 150 F ($30).    



Rulers
Indicates exact measures of document according to the size of the printed document.
Rulers display can be inactivated with the Rulers command of the Options menu.



Guides
Horizontal or vertical lines that attract the mouse. They allow the structuration of a 
document and the precise positioning of objects.



Grids
Set of points, horizontally and vertically aligned with regular and definable step.
There is two different grids:

• the Visual grid for the display of a grid on screen. This grid is not printed.
• the Magnetic grid for attracting the mouse to nearest grid point. 
The step of each grid can be different than the other.



Impact
Dos based vector drawing program, for VGA display and supporting the mouse and 
compatible Epson printer.



Block control points
Points that have a squared form. There are located at the four corners and on the sides of a 
rectangle containig the selection.
Those block control points allows the deformation and the sizing of selected objects.



Path control point
Points located on a drawing path and that have a squared form and a smaller size than the 
block control points.
A drawing path can have different types of path control points (arc, line, spline, Bezier).
The first path control point of a drawing path is smaller than the others.



Style
The style is the attributes of an objects.
For a drawing object, the style contains the thickness of contour, contour and filling colours, 
as it is defined with the Drawing... dialog box.
A Vincent text the style contains also text attributes like the font, the size of characters, 
etc.



Vincent Text
Text created with special Vincent fonts. A Vincent text can be submitted to all deformations 
and effects like any Vincent drawing object
A Vincent text is constituted of a single line, with 40 characters max and is created with the 
Text tool.
Text attributes of a Vincent text is modifiable with the Vincent text attributes dialog box 
accessible with the Text command of Attributes menu.
Multiline blocks text using Windows fonts (True Type, ATM, etc.) can be realized.



Windows Text
Text created with a Windows font (True Type, ATM, etc.).
Windows texts are created by activating Text tool and by drawing with the mouse a 
rectangle while activating the Ctrl key. That open a text editor allowing the edition of text.



Approach
Spacing between characters.



Status line
Display information on the main Vincent Window:
from left to right:

• the coordinates of the mouse cursor, in millimeters, with a 1/10 mm precision.
• zoom rate, or rotation angle when the Rotation  tool is active.
• selected objects number.
• the size of the selection, in millimeters.
• the area in mm² of a single selected drawing element.
• contextual help information or the order of display for a selected object, when the mouse 

cursor is over this zone of the status line.
• colour components (Red, Green, Blue,Light, Saturation, Cyan, Magenta, Yellow, Black) on 

the right part of the status line when the mouse cursor is over a colour of the palettes.



Bitmap
Bitmaps are created in a paint program, such as Windows Paintbrush.

Bitmaps can be pasted into a Vincent document    via the Windows Clipboard.

It is possible to modify the colour of a monochrome bitmap:
• select monochrome bitmap,
• clic on a colour of the palettes.

Horizontal and vertical symmetry can be applied to bitmaps..



Fin de v_terms



Dialog boxes

Vincent text attributes
Drawing attributes
Quotation
Palette colours
Gradation
Keyboard
Layers control Window
Clip-Art
Comet
Quotation scale
Bezier surface

Grid
Preferences
Toolbars configuration
Paving
Shapes gradation
Info Window
Paste Special



Colour palette

You have two types of palettes: a floating palette that you can place wherever on the screen 
and a permanent palette on the bottom of the main window of Vincent.

These 2 types of palette are composed of 8 distinct sub-palettes (of 16 colours each).

It is possible to create new palettes, to modify them and to save them (Colour... command 
of the Attributes menu).

Two manners to apply a colour:
Classic method:

• select the element to colour,
• click with a mouse button on a colour of the palette.    

Drag and drop method:
• activate a mouse button on a colour of the palette; 
• displace the mouse until reaching the element to colour (the cursor resembles then a 

pot of paint);
• release the mouse button.

To apply a colour:
• inside a drawing path or to a Vincent text:

.    Classic method with the left button.
or
.    Drag and drop method with the left button.

• to the contour of a drawing path or to the contour of a Vincent text:
.    Classic method with the right button.
or
.    Method drag and drop with the right button.

• to Windows text:
.    Classic method with the left button.
or
.    Method drag and drop with the left button.

• to the background of a Windows text:
.    Classic method with the straight bud.
or
.    Method drag and drop with the straight bud.
Notes:
- The background of a Windows text can be assigned only a pure colour, the number of 

available colours depends on your screen and your graphics adapter.
- The bottom of a block of Windows text can be transparent: select the block of    

Windows text, open the Drawing attributes dialog box, then activate the 
Transparent radio button.

- The option Saving with palette of the Preferences dialog box allows to save the 
sub-palette with the document.

To modify colours of elements of a group:
• Drag and drop method with the left button for the background or the right button for 

contours.

To remove or active the floating palette:
• Activate the command Colour Palette of the Option Menu



See also:
Modification of beginning and end colours of a gradation



Vincent Text... Attributes menu        
Opens the Vincent text attributes dialog box.
This dialog box allows to modify attributes of one (or several) selected Vincent text.

Accessible also from the popup Attributes menu.

Using Vincent text attributes dialog box:

• the size (in point Didot (1 point didot = 0,3759 mm), can have a value of 1 to 999 points.

• the italic can vary from -45 to +45.    A negative value creates a left slanting italic.

• the width (in percentage), corresponding to an expansion or to a reduction of the width 
of characters. can have a value of 1 % to 1000%.

• the approach (in percentage of the height of characters), corresponding to    the distance
separating characters, can have a value of -50% to 100%. A negative approach puts 
characters in recovery.

A Vincent text    has text attributes and also drawing attributes. All these attributes 
constitute its style. To allocate the same attributes to another Vincent    text, copy and 
paste the style..

See also:
Creating Vincent text
Creating Windows text
Text tool
Text editor



Drawing... Attributes menu        
Opens the Drawing attributes dialog box.

This dialog box allows to modify attributes of one (or several) selected drawing elements.

Drawing attributes are:    line thickness, fill and contour colours, open (only contour) or 
closed (element filled), drawing and filling modes, transparent or opaque (for a 
Windows text background) and the mask attribute.

Drawing attributes of an object constitute it style.    To allocate the same drawing attributes 
to an other object copy and paste the style.

Using the Drawing attributes dialog box:

• Line thickness: indicates in tenths of millimeters the thickness of the contour of the 
selected element and can have a value of 0 to 1000.

• Closed: select this option if you want selected element(s) to be closed (filled with colour).

• Drawing mode: defines the mode of paint. This mode determines the manner according 
to whether interiors of objects and their contours are combined to existent colours on the 
surface of document
In given examples below, the drawing mode is assigned to the form number 2 and colours
are identical for all examples.

 Copy: normal mode, by default.

 And: combination of the common colours of the bottom and the object.

 Or: combination of the colour of the object and the colour of the bottom.

 Xor: combination of colours that are in the bottom and in the object but not in either.

• Filling: example



 on the left Alternate fill, on the right Winding fill.

• Background:determines if the bottom of a block of Windows text has to be opaque (fill) 
or transparent (objects placed under are visible).      
The Mask attribute allows an object to be seen in an other object with which it is 
grouped. For example a bitmap (or drawing elements, or Vincent text) can be solely 
visible inside a drawing element or a Vincent text.
• Select a drawing element or a Vincent text.
• Allocate to this element the Mask attribute. The element has to be closed, check the 
Closed option if necessary.

• Group this element with one or several other elements (drawing elements, bitmap, 
group, Vincent text, paving...).

The other elements appear only inside the element that has the Mask attribute.

• Line and Fill: to modify contour and fill colour of selected elements.
• click with the left mouse button on Line or Fill zone that opens a small colour palette, 

then click on the wished colour.
or
• click with the right mouse button on Line or Fill zone that opens a chromatic wheel 

(HLS colours), then click with left mouse button on the wished colour.
or
• press the left mouse button on a wished colour of the standard palette,

- move the mouse until reaching Line or Fill zone of Drawing Attributes dialog box 
(mouse cursor then looks like a pot of paint),

- release mouse button.

Note: Drawing... command is accessible from popup menu Attributes.



Quotation... Attributes menu        
Opens the Quotations - Extremities dialog box.

To realize quotations, with Vincent is very simple: draw a line or a broken line, activate 
the command Quotation of the Attributes menu (or the popup Attributes menu ), 
indicate parameters of the quotation (shape of extremities position of the quotation, font, 
scale...).

Quotation parameters constitute a style: to allocate the same parameters of quotation to an
other line use copy and paste the style.

Using of the Quotations - Extremities dialog box:

• Select the shape of extremities for the Beginning and the End of the line (in the order of 
the drawing). The option Without inactivates parameters of the quotation and therefore 
suppresses the quotation. 

• Inverted: inverts the direction of the extremities Arrows and Feather.
• Closed: closes the contour of the extremities Arrows and Feather.
• Quotation: displays the value of the quotation.
• Multiline: puts extremities at the beginning and at the end of all segments of a broken 

line. When this checkbox is not activated alone the first and the last points of a broken 
line have an extremity.

• Coloured: filled extremities with the active filling colour.
• Wedges: puts wedges at the beginning and at the end of a quotation.

• Size: indicates the size of extremities in tenths of millimeters.
• Angle:    indicates the angle of the extremities Arrows and Feather.
• Sup.: indicates the length of the upper part of wedges in tenths of millimeters,for a 

quotation line drawn from the right to the left. If the line has been drawn from the left to 
the right Sup. indicates the length of the lower wedge portion.

•  Inf.:    indicates the length of the lower part of wedges in tenths of millimeters,for a 
quotation line drawn from the right to the left. If the line has been drawn from the left to 
the right Inf. indicates the length of the upper wedge part.

• Quotation pos.: indicates the distance between the text of the quotation and the line of 
the quotation, in tenths of millimeters. Negative values are admitted. A positive value 
places the quotation above the quotation line if the line has been drawn from the left to 
the right.

• The Scale... button opens the Quotation scale dialog box allowing to configure the 
scale of the quotation and its format (number of wholes and decimals).

• The fonts... button opens the standard Windows Fonts dialog box allowing to modify the 
font, the size and the style of the quotation.

Suppression of a quotation:
• Activate the command Remove quotation of the popup Attributes menu. Remove 
quotation inactivates parameters of the quotation but preserves the line.

Modification of a quotation:
• Select a quotation.
• Activate the command Quotation....of the Attributes menu.





Quotation scale

The dialog box Quotation scale allows to configure the scale, the unit and the format of the
quotation (number of integers and decimals).

Ratio:
Indicate in the first member the numerator and in the second member the divisor of the 
scale. For example for a scale of 1/50 indicate 1in the first zone and 50 in the second. A 
quotation is expressed in tenths of mm. To express the quotation in cm, multiply by 100 the 
value of the first member (1 cm = 100 tenths of mm).

Unit:
Indicate a wording for the display of units on the quotation (for example cm, mm, m, km, 
etc).

Format:
Indicate in the first member the number of integers and in the second member the number 
of decimals wished.



Colour... Attributes menu        
Opens the Palette colours dialog box.

This dialog box allows to modify the colours of the palette (floating plalette and permanent 
palette on the bottom of the main window ).

The command Preferences of Options menu allows to save the palette with the document.

Using the Palette colours dialog box:

To select a palette:    the vertical translator on the left of the dialog box allows access to 
8 sub-palettes. By activating the Ok button the new palette replaces the precedent in the 
floating palette.

To modify or define a colour:
• The six horizontal translators allow to modify Red, Green and Blue components (RGB 

colour), and also the Hue, Light and Saturation (HLS) of a selected colour.
• The CMYK edit zones allow to modify Cyan, Magenta, Yellow and Black values of a CMYK 

colour components
• Activating the left mouse button over a wished colour of the chromatic HLS wheel allows 

to choose a colour. The vertical zone on the right of the wheel modifies the light 
component.

• With the floating palette:
. click with a mouse button on the wished colour of the floating palette,
. displace the mouse until reaching the colour to be modified (the cursor then looks like a 

pot of paint),
. release the mouse button.

• Activating the right mouse button over one of the 16 colours displays a mini-palette 
regrouping 8 sub palettes. Click with the left button on the wished colour (the right button
cancels) and close the mini-palette. 

Open: opens a file with '.PAL' extension containing palettes. The new palettes replace the 
precedents. Activate the Cancel button to return to preceding palettes The palette files 
created by Paint Shop Pro (® JASC) are also opened. Note that only the 128 first colours are
used.

Save: save the palettes into a file with '.PAL' extension.

The standard Windows Colour dialog box is accessible by activating Colour... command and
by pressing in the same time the Shift key. This standard Windows Colour dialog box allows
to modify the 16 visible colours of the floating palette.



Gradation... Attributes menu        
Opens the Gradation dialog box.

Using the Gradation dialog box:

To apply a gradation to a shape, this shape has to be selected and closed (see Drawing... 
dialog box).

Type
Choose the type of gradation: None, Parallel, Circular, Square.
Periodic option is available only for circular and square gradations.

Note: periodic effect is not exportable in postscript.

Increment
Step: indicates the thickness of gradation bands in tenths of mm. Must have a value 
between 1 and 1000.
Angle: indicates the incline of bands in degrees for a parallel gradation. Must have a 
value between 0 and 90 degrees.

Centre position
Horizontal and Vertical: indicates the position of the center of gradation for a circular or 
a square gradation. For example horizontal and vertical values of 0 % put the center of 
gradation on the top and on the left of a rectangle containing the element.

Modification of the beginning and end colours of a gradation:
• click with the left mouse button on the Beginning or the End zone for opening a palette

and then click with left button on a wished colour.
or drag method:
• activate    the left mouse button on a colour of the palette.
• displace the mouse until reaching the Beginning or End zone (the cursor then looks 

like a pot of paint);
• release the button of the mouse.

Modification of beginning and end colours of a gradation without 
using Gradation dialog boc:

• select a form previously gradated,
• click with left mouse button on a colour of the palette to change the debut colour of 

gradation,
• click with left mouse button while holding the Shift key down on a colour of the palette to

change the final colour of gradation.

HLS: (for Hue, Light, Saturation)
Check this box for getting an HLS gradation Otherwise gradations are RVB (red, green, blue).

Note: Gradation dialog box is accessible by popup Atributes menu.



Keyboard... Attributes menu        
Opens Keyboard window.

Using the keyboard with a Vincent text:
• Select a Vincent text or create a Vincent text with the Text tool.
• Open Keyboard window with Keyboard... command of Attributes menu or popup 
attributes menu. 

• Click on a character to add it to the text at the cursor position. The active font is indicated
on the title board of the Keyboard window.

Using the keyboard with a Windows text:
• Select a Windows text or create a Windows text with the Text tool.
• Activate the Keyboard... command of File menu of Text editor,
• Click on a character to add it to the text at the cursor position



Layers... Attributes menu        
Opens the Layers control window.

The Layers control window allows to manage up to 16000 plans. On each plan objects can 
be in Normal display , Rapid 

 or Invisible 
. The Invisible or Rapid options allows the faster display of documents containing a lot of

objects (bitmaps for example).

Objects situated on an other layer than the active layer are not accessible with the mouse.
It is possible to copy or move objects from a layer to an other layer.

Using the Layers control window:

Active: indicates the name of the active layer.

The list of layers on the left indicates the name of all existing layers.
• Click on a layer to select it.
• Double click on a layer name to make it the active layer.
• Click on a layer name with right button to make it alternatively in rapid, invisible or 

normal display.

Active button makes the selected layer active.

Add button allows the creation of a new layer. Indicate into the Vincent-Layer dialog box    
a name for the new layer.

Rename button allows to change the name of the selected layer. Indicate into the Vincent-
Layer dialog box    a new name for the selected layer.

Remove button deletes (after confirmation) the selected layer and all the elements 
belonging to that layer. The active layer can not be deleted.

Active only option makes visible  only the active layer.

The little buttons V , I 
 and R 
 make respectively all the layers (except the active layer) in normal, invisible or rapid 

display.
Note: active layer can be in rapid  or in normal 

 display but not invisible 
.

Close button closes the Layers control window.



Comet dialog box

Allows to modify the parameters of a selected Comet created with the Comet tool.

The Point group options allows to define the form (circle, triangle, lozenge, square, multiple)
of the basic elements of the comet. Multiple option allows to cobine all forms.

Free angle option allows to put in rotation the basic elements according to random angles.

Valid option allows to edit progression values (Number , Comet radius, Point radius) from 
the beginning to the end of the initial mouse drawing.

Number: indicates the number of basics elements to generate around each point of initial 
drawing.

Comet radius: indicates the radius in tenths of mm of the distribution of basic elements 
around each point of the initial drawing.

Points radius: indicates the radius (or the size) in tenths of mm    of each basic element.



Bezier Surface dialog box

Modifies the display of surfaces generated by Drive Surface.
Accessible by the command Edit Drive Surface of the popup Attributes menu.

Lines: display only the lines.
Vertical Lines: display only vertical lines.
Horizontal lignes: display only horizontal lines.
One colour: coloured all the squares of the surface with one colour.
Checked: coloured all the squares of the surface with two colours as a checkerboard.
Gradation: coloured all the squares of the surface with gradated colours from 4 initial 
colours on the 4 extremities of the surface.

To modify colours:
• activate    the left mouse button on a colour of the palette.
• displace the mouse until reaching a colour zone (the cursor resembles then a pot of 

paint);
• release the mouse button.



Paving dialog box

Dialog box allowing to modify paving attributes:
• Select a paving element.
• Activate simultaneously Ctrl and E keys (or click with the right mouse button on the Text 

tool )
• Visible check box allows to display (when checked) or not (faster display) paving 
elements.
• Indicate in X and Y horizontal and vertical spacing between elements.

Note: to create a paving, use Paving command of Modify menu.



Shapes gradation dialog box

Dialog box allowing to indicate the number of elements to generate from two selected 
drawing elements (these elements must have the same control drawing points number).

This dialog box is accessible from the Blend forms command of the popup Attributes 
menu.

To realize a shapes gradation:
• Draw a first element with the tools line, spline, arc, ellipse, square...
• Draw a second element with the same control drawing points number (or duplicate the 

first one and modify its proportions).
Note: elements can be put in rotation, italicized, put in spherical projection... These 
deformations are also submitted to shapes gradation.

• Select the two elements.
• Activate Blend forms command of popup Attributes menu.
• Use horizontal translator to specify the number of elements to generate.
• Activate the HLS checkbox to modify colours of each generated element according to HLS

(Hue, Light, Saturation) gradation. Otherwise, the colour gradation is a RGB (Red, Green, 
Blue).



Paste Special dialog box

Dialog box allowing to choose a format from the clipboard.

The list can contain the following formats:
• Vincent: this format contains all specific Vincent graphic information; it is the format by 

default when the Paste command is used.
• Metafile: it is the Windows vector format. 
• Bitmap: it is the bitmap formap generated by bitmap editors like Paint Shop Pro or 

Windows Paintbrush for example.
• Bitmap DIB: all resolutions bitmap (24 bits, 16 M colours only).
• Drive-Surface: format generated by the program drvsurf.exe of Drive-Surface.

Voir: Preferences dialog box.



Fin de dialog




